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Použití 

Software nVision poskytuje uživateli možnost stahování, editování, uchovávání, analyzování a tištění dat získaných 
měřením pulsními oxymetry Nonin. 
 
nVision umožňuje uživateli stahování dat z oxymetrů, které mají interní paměť a uložit je v PC s následujícími 
operačními systémy: Windows XP SP3, Vista, W7 (32 a 64 bit), W10 (32 a 64 bit).  
 
Další požadavky na PC: 
- min 133 MHz Pentium mikroprocesor nebo ekvivalent 
- min 256 Mb RAM 
- min 20 MB volný prostor na hard disku 
- CD/DVD 
- vide karta min 800 x 600 VGA rozlišení 
- min 1 komunikační port 
 

Instalace software: 
 
1. Vložte nVision CD do PC 
2. Instalační program by měl začít automaticky 
3. Sledujte postup instalace, do políčka registrace napište instalační kód (včetně mezer), který najdete na obalu CD 
    Tento kód můžete najít kliknutím na HELP → About nVision 
 
Pokud se nVision sám neinstaluje, pak : 
 
1. Vložte nVision CD do PC 
2. Z menu Start vyberte Spustit  
3. Otevřete soubor D:setup.exe, kde D je CD/DVD šachta 
4. Sledujte postup instalace 
 
Otevření software: 
 
1. Klikněte na ikonu nVision, nebo najděte software pomocí start, hledat, nVision 
 
Odinstalování software :  
 
1. Klikněte na start  → Aplikace a funkce → klikněte na nVision a odinstalujte 
2. Sledujte postup odinstalace a odpovídejte „ano“ … 
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Začínáme  
 
nVision software je jedna část ze systému sestávajícího se z Nonin pulsní oxymetry, vhodný datový kabel nebo 
Bluetooth spojení, PC s tiskárnou a nVision software. nVision není síťová aplikace. 
 
Následující specifické kabely, adaptery nebo moduly jsou vyžadovány pro stahování dat. Jsou pro přehled uvedeny i ty 
přístroje a zařízení, které se již nevyrábí, nebo nejsou v ČR v prodeji. 
 

 
 

Kabel/Adapter/Modul 
 
Modely oxymetrů a kapnometrů  
 

 
UNI-RS232 

 
2120, 4000, 9600, 9700 
 

 
1000MC / 1000RTC 

 
2500, 2500A, 8500M, 9843, 9845, 9847 

 
1000PFC 

 

 
8600M, 8600FOM 
 

 
1000SC-WO 

 

 
3100 
 

 
        3150SC nebo bluetooth 

 
3150 
 

 
3150SC 

 

 
3150 USB, 3150 BLE 

 
7500SC 

 

 
7500, 7500FO 

 
TrendSense 

 
LifeSense, RespSense 
 

 
TrendSense Computer cable 
TrendSense Waveform Kit 

 

 
LifeSense II, RespSense II 

 
 
Poznámky : 
 

 Aby data byla do PC uložena ve správném času, musí být čas a datum být nastaveny v oxymetrech před jejich 
použitím. Pokud tomu tak není nVision přiřadí datum a čas ke stahovaným datům podle datumu stahování dat. 

 nVision zobrazí chybovou hlášku, pokud data nejsou stažena správně. 
 Data zůstávají v paměti oxymetrů i po stažení do PC do té doby, kdy jsou z paměti oxymetrů smazána. 
 Jenom jedny data mohou otevřena být v nVison. 

 Data mohou být exportována a uložena ve formátech *.pdf a *. Asc. 
 „událost“ je definována uživatelem nastavením parametrů (edit – analysis parameters) a nastane tehdy, když 

tyto nastavené parametry jsou dosaženy nebo překročeny. 
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Poznámky k comm portům : 
 

 Při použití sériových kabelů RS232 budou s největší pravděpodobností použity comm 1 nebo comm 2 
 Při použití sériového kabelu s USB adapterem určí příslušný comm port následující kroky 

a. odpojte USB adapter z PC 
b. jděte do správce nastavení počítače a rozšiřte porty COM & LPT. 
c. Zastrčte USB adapter do PC, v nVision klikněte u portů na refresh a nový port se zobrazí (může se zobrazit 
USB, Serial comm port) 
 

 
 
 
 
 
 

Hlavní rysy nVision 
 
Nástrojová lišta 
 
Jako doplněk k pěti hlavním volbám (File, Edit, Options, Report, Help) má nVision nástrojovou lištu s nejvíce 

používanými symboly, zkratkami.  Například tento známý symbol   označuje tisk, tento symbol  zobrazuje 
parametry … . 
 

 
 
  
 
Stavový graf 
 
Stavový graf má tři sekce a je ve spodní  části okna software. Používá se se Strip Chart (pásový, řádkový graf) a Full 
Study Report (úplná zpráva). 
 

 
 
 
 
Display time. Levá sekce stavového grafu. Toto pole ukazuje délku času, který se zobrazuje na displeji. Nastavit lze 
prostřednictvím Options > Display Parameters > Time Interval. 
 
 
Elapsed time. Prostřední sekce. Toto pole ukazuje uplynulý čas rolování během kterého se uživatel dostal k datům 
zobrazených na monitoru. 
 
 
Selected Time or Cursor Time. Selected time značí počátek pro vybranou oblast zájmu a dobu trvání v sec. v této 
oblasti. Cursor time. Kliknutím levým tlačítkem v grafu zobrazíte čas pro určitý bod v 
grafu. Kliknutím a podržením tlačítka myši zobrazíte čas kurzoru s hodnotami dat SpO2 a tepové frekvence pro určitý 
bod v grafu. 
 
 



 

5 

 

 

Menu File 
 

 
 
New Data Capture - Stahování nových dat.  Funkce New Data Capture stahuje data z Nonin pulzních oxymetrú. 
Chcete-li ukládat data do paměti pulzního oxymetru, monitorovací doba musí být alespoň 1 minuta. Klikněte na File> 
New Data Capture, nebo na ikonu Data Capture a otevřete následující dialogové okno New Data Capture. 
 

 
 
 
1.  Status, stav - zobrazuje zprávy o stavu (např. Waiting - čekání ..., Receiving - příjem ...). 
2.  Start Date / Start Time - Zobrazuje čas a datum stahovaného záznamu. 
3.  Time Received - Aktualizuje se pravidelně, indikuje počet hodin dat, které byly staženy. 
4.  Select Communication port  - Vyberte komunikační port - nabídne seznam comm portů počítače 
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5.  Refresh Button - tlačítko Aktualizovat - aktualizuje seznam komunikačních portů v Select Communications Port 
6.  Select oximeter box – výběr oxymetrů - seznam pulzních oxymetrů, které komunikují s nVISION 
7.  Instruction box - uvádí pokyny specifické pro stahování dat z konkrétních modelů pulsních oximetrů 
8.  Progress bar – ukazuje průběh stahování dat 
9.  Captured Recordings box - Aktualizace po stažení každého záznamu z oxymetru, přičemž poslední záznam je 
      zobrazen nahoře. 
10. Start Button -  Začne proces stahování dat  
11. Stop Button - Umožňuje uživateli ukončit proces stahování po již stažených datech, segmenty jsou uvedeny  
      v poli Captured Recordings box  
12. Settings button - Otevře dialogové okno Settings dialog box.. Toto dialogové okno se používá pouze k nastavení 
      a programování oxymetrů 3100 a 3150. 
13. Cancel button – přeruší průběh stahování dat. 
 
 
Funkce Settings Button – nastavení oxymetrů WristOx (3100), WristOx2 (3150),  
 

 
 
1.  Current Date/Time – zobrazí datum a čas nastavený v oxymetrech 
2.  Sync with PC Button – synchronizace datumu a času oxymetrů s datum a časem počítače. 
3.   Display – Volbami jsou Full, Partial, a MVI (3150 pouze). Celý displej (Full) ukazuje % SpO2 a tepovou frekvenci. 
      Částečný displej (Partial) zobrazuje indikátor síly impulsu, ale ne % SpO2 a puls. Displej MVI (objem 
      paměti) zobrazuje indikátor síly impulzu a objem dat (hodiny a minuty)  uložených v paměti,  ne však % SpO2  
      a  tepovou frekvenci. 
4.  Sample Rate - Rychlost ukládání dat pacienta do oxymetru lze nastavit  na intervaly 1, 2 nebo 4 sekundy.  
      Data uchovaná v paměti s různým časovým intervalem nelze sloučit. 
5.  Activation Option - Režimy zapnutí oxymetrů.  Možnosti zahrnují zapnutí oxymetrů připojením senzoru, vložením    
     prstu do již připojeného senzoru naprogramování na datum a čas. Další informace v uživatelské příručce oxymetrů. 
6.  Sensor Activation - oxymetr se zapne po stisknutí aktivačního tlačítka, nebo kdy je senzor odpojen a znovu připojen. 
7.  Spot Checking – standardní (defaultní) nastavení oxymetrů, které se zapnou a vypnou po vložení a vysunutí prstu ze 
     senzoru. 
8.  Programmed - Umožňuje naprogramování spouštění a zastavení funkce oxymetru až na tři relace. Pro fungování  
     v programovacím režimu musí být nastaven alespoň jeden interval a čas oxymetru zařízení musí být správně 
     nastaven.  Pokud tyto podmínky nejsou splněny, zobrazí se následující zpráva: Warning - Settings may prevent data  
     collection. Continue? 



 

7 

 

 
9.   Bluetooth – zapnutí bletooth pouze pro Oxymetr 3150.  
10. Patient ID – prostor pro označení pacienta 
11. Software Part Number/Revision – informace o software oxymetru 
12. OK button – Potvrdí naprogramování aktuálního nastavení oxmyetru. Dialogové okno se zavře a nVISION  
       se vrací do dialogového okna New Data Capture. 
13. Cancel Button - Zruší aktuální nastavení. Dialogové okno se zavře a nVISION se vrací k oknu New Data Capture. 
14. Clear Memory button -  Vymaže paměť oxymetru. Pop-up zpráva požádá OK o vymazat paměť pacienta? Klepnutím   
      na tlačítko Ano vymažete paměť a vrátíte se do dialogového okna Settings. Kliknutím na Ne nebo Storno se vrátíte  
      do dialogového okna Settings  bez vymazání paměti. 
 
 
Otevřít uložená data(Open Saved Data) 
 
Uložená data otevřete kliknutím na File> Open saved data nebo na ikonu Open. Otevře se dialogové okno Otevřít 
uložená data do výchozího adresáře.  Pozn. dialogové okno Otevřít uložená data se otevře v přednastaveném 
(deafultním) adresáři. 
 
 
Uzavřít otevřená data Close) 
 
Abyste uzavřeli otevřená data klikněte na File> Close. nVision zůstane otevřený. 
 
 
Uložit (Save) 
 
Chcete-li uložit otevřená data se stejným názvem souboru, klikněte na File> Save. Případ je uložen a přepíše předchozí 
sadu dat. Pozn.  nVISION automaticky neukládá otevřené soubory. Změny provedené v souboru před jeho uzavřením 
musí být nejprve uloženy.. 
 
Uložit jako (Save As) 
 

 
 
Funkce Uložit jako umožňuje uživateli upravit existující datovou sadu a uložit ji do jiného souboru (s jiným názvem) při 
zachování původní sady dat. 
 
1. Při otevřené sadě dat klikněte na Soubor> Uložit  jako. Zobrazí se dialogové okno Uložit data jako. Datové sady lze 
uložit do libovolného adresáře nastavením přes Možnosti> Data Cesta (Options> Data Path). 
 
2. Výchozí název nové sady dat je existující název souboru s číslem v závorce (počet kopie sady dat, které byly 
uložené). Použijte toto jméno nebo zadejte nový název do pole Název souboru (File Name Box) 
 
3. Klikněte na Uložit. Soubor dat s novým název souboru se stane otevřenou datovou sadou. 
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Import 
 

 
 
Funkce Import umožňuje uživateli importovat soubor ASCII do adresáře DataSets a do databáze historie pacientů. 
 
POZNÁMKA: Při importu případu se uzavře každý otevřený případ. 
 
1. Při otevřené sadě dat klikněte na Soubor> Uložit jako. Zobrazí se dialogové okno Uložit data jako. 
2. Vyhledejte a klikněte na soubor dat, který má být importován. Výchozí složka je výchozí cesta pro ukládání dat 
nastavena prostřednictvím Možnosti> Datová cesta (Option > Data Path). 
3. Vyberte sadu dat. 
4. Klepněte na Otevřít (Open). Datová sada se zobrazí jako Oximetrická zpráva (Oximetry Report). 
5. Klepnutím na tlačítko Storno zavřete dialogové okno bez importu dat. 
 
Export 
 

 
 
Funkce Export umožňuje uživateli exportovat data z nVISION do PDF (.pdf) nebo čárkami oddělený soubor formátu 
ASCII (.asc). Data uložená ve formátu .asc lze zobrazit a vyhodnotit pomocí tabulkového software (např. Excel) . Data 
uložená ve formátu .pdf lze zobrazit pomocí aplikace Adobe Reader. 
 
V souboru .asc  se informace o pacientech zobrazí v horní části tabulky a za nimi následují řádky dat. Každý řádek 
údajů obsahuje ID pacienta, rok, měsíc, den, hodina, min, sec, tepovou frekvenci, % SpO2, a frekvenci dýchání (pokud 
je k dispozici). 
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1. Během prohlížení případu klikněte na File>Export. Zobrazí se dialogové okno Exportovat data. 
2. Určete umístění pro uložení případu. Výchozí složka je výchozí adresář (nastaven přes Možnosti> Data Cesta). 
3. Název souboru se automaticky vyplní. Změňte podle potřeby. 
4. V rozevíracím seznamu Uložit jako vyberte buď .pdf nebo .asc. 
5. Klepněte na Uložit. 
 
Pozn. PDF soubory nemohou být zpětně v nVision zobrazeny. 
 
Uložení XML dat (Save XML Data) 
  
Funkce Uložit data XML je k dispozici pouze tehdy, kdy je sada dat otevřena jako zpráva oxymetrie (Oximetry Report). 
 
Příkaz Save XML Data vytvoří soubor XML a dva přidružené soubory PNG (např. FileName.xml; fileName.pulse.png; 
fileName.spo2.png). Tyto tři soubory jsou uloženy do složky XMLData a musí zůstat ve stejném adresáři, aby se 
správně zobrazily. Soubor XML má stejný název jako soubor .nmi sady dat. Soubory .png jsou SpO2 a pulzní graf, na 
které se odkazuje v souboru XML. Po uložení nelze soubory XML znovu uložit, dokud není studie znovu otevřena (File > 
Open Saved Data). 
 
Tisk (Print) 
 

 
 
Chcete-li sestavu vytisknout, klikněte na Soubor> Tisk nebo na ikonu Tisk pro zobrazení dialogového okna Tisk. 
Viz část „Nabídka Report“ (Report Menu) informace o různých typech zpráv, které jsou k dispozici. 
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Náhled tisku (Print Preview) 
 

 
 
Funkce Náhled tisku slouží k zobrazení toho, jak se report objeví při tisku. Chcete-li zobrazit náhled sestavy, klikněte na 
Soubor> Náhled tisku nebo ikonu náhledu tisku. Okno Náhled tisku zobrazí se pomocí následujících tlačítek. 
 
• Tisk - zobrazí dialogové okno Tisk. 
• Další stránka / Předchozí stránka (Next/Previous Page) - navigace stránkami na více-stránkovém reportu. 
• Jedna stránka / dvě stránky - střídá se mezi a zobrazení jedné a dvou stránek sestavy. 
• Zoom In / Zoom Out - zvětšení nebo zmenšení obsahu zprávy. 
• Zavřít - zavře okno Náhled tisku. 
 
Tisk Setup (Print Setup) 
 

 
 
Nastavení tisku vybere tiskárnu a připojení tiskárny. 
Klepnutím na Soubor> Nastavení tisku zobrazíte okno Nastavení tisku 
Nastavte tiskárnu podle potřeby a klikněte na OK. 
Klepnutím na tlačítko Storno zavřete dialogové okno bez uložení změn. 
 
Ukončení práce software (Exit) 
Chcete-li ukončit software, klikněte na Soubor> Konec (File >  Exit). 
POZNÁMKA: Změny v sadě dat se neuloží, pokud není soubor uložen pomocí Uložit nebo Uložit jako. 
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Menu editování, úprav (Edit Menu) 
 

 
 
 
Sumarizace dat 
 
Možnost Sumarizace dat je k dispozici pouze v případě, že byla vybrána oblast zájmu v čárovém grafu (Strip Chart 
Report). Chcete-li zobrazit, vyberte oblast zájmu a poté klikněte na Upravit> Souhrnná data (Edit > Summarize Data). 
Zobrazí se dialogové okno Souhrnná statistika (Summary Statistics). 
 

 
 
1. Časový interval (Time Interval) - čas zahájení, čas ukončení a délka časového intervalu pro vybranou oblast 
zájmu. 
2. Nadpisy sloupců (SpO2, tepová frekvence, respRate [respirační frekvence]) pro data kategorie, které mohou být  
ve Strip Chart Report. 
3. Průměrné, minimální a maximální hodnoty v každé kategorii dat během časového intervalu. 
4. Počet událostí, které se vyskytly v každé kategorii dat během časového intervalu. 
5. Exclude button - Tlačítko Vyloučit - Otevře dialogové okno Vyloučit segmenty dat. 
6. Tlačítko Cancel  - Zavře dialogové okno Souhrnná statistika a odstraní oblast zájmu ze zprávy Strip Chart. Data 
zůstávají v analýze. 
 
Výběr oblasti zájmu 
 
Zájmová oblast nakreslená na pruhovém grafu (Strip Chart) a označená červeným čárkovaným obdélníkem se používá 
k analýze konkrétního bloku dat. Uživatel si může prohlédnout statistické shrnutí údajů uvnitř obdélníku a poté 
identifikujte a vyberte oblasti artefaktu (poškozená nebo nesmyslná data), které mají být vyloučeny z analýzy. 
 
1. Otevřete data a zobrazte je jako sestavu Strip Chart Report. 
2. Pomocí myši umístěte kurzor na jeden okraj požadované oblasti v datovém grafu. Stiskněte a podržte levé tlačítko  
    myši. 
3. Přetáhněte kurzor přes požadovanou oblast. Jakmile je kurzor přetažen, hranice vybrané oblasti jsou definovány  
    červeným obdélníkem. 
4. Jakmile je oblast zájmu vybrána, uvolněte tlačítko myši. Červená přerušovaná čára obdélníku zůstává. 
5. Klepnutím na Úpravy> Souhrnná data (Edit > Summarize Data) nebo na ikonu Souhrnná data zobrazíte dialogové  
    okno Souhrnná statistika. 
6. Klepnutím na Vyloučit přidáte časový interval do seznamu vyloučených segmentů dat.  Zobrazí se dialogové okno  
    Datové segmenty. Další informace naleznete v části „Vyloučení dat“. 
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Vyloučená data 
 

 
 
Funkce Vyloučit data umožňuje uživateli odstranit, vyloučit nebo odmítnout podezřelé segmenty dat z analýzy dat. 
Vyloučená data jsou vyšrafována, když jsou prohlížena na monitoru nebo vytištěna (Oximetry, Strip Chart nebo Full 
report). 
 
Vyloučení dat 
 

 
 
1. Otevřete data a zobrazte je jako sestava Strip Chart  Report a vyberte oblast zájmu. 
2. Klikněte na Úpravy> Vyloučit data (Edit > Exclude Data) nebo na ikonu Vyloučit data. Zobrazí se dialogové okno   
    Vyloučit datové segmenty (Exclude Data Segments).  Zvýrazněte vybraný interval v seznam vyloučených segmentů. 
3. Chcete-li zvýrazněný segment vyloučit, klikněte na OK. Dialogové okno se zavře 
4. Pro zrušení procesu vyloučení dat vyberte segment dat a klikněte na Vrátit zpět či Vrátit vše (Undo nebo Undo All). 
    • Vrátit zpět - vybraný segment dat již není vyloučen z analýzy. Dialogové okno se zavře. 
    • Vrátit vše - všechny zobrazené segmenty dat  nejsou vyloučeny z analýzy. Dialogové okno se zavře. 
 
POZNÁMKA: Vyloučené údaje jsou zahrnuty do výpočtu % artefaktu a použité doby trvání pro výpočet indexu. 
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Informace o pacientovi (Patient info) 
 
Funkce Informace o pacientovi umožňuje uživatelům provádět změny informací o pacientech. 
1. Otevřete sadu dat. 
2. Klikněte na Upravit> Informace o pacientovi (Edit >  Patient Info). Otevře se dialogové okno Edit Patient Info. 
3. Upravte informace o pacientovi. 
• Klikněte na aktualizovat (Update). Aktualizace informací o pacientovi se uloží a dialogové okno se zavře. 
• Klikněte na zrušit (Cancel). Dialogové okno se zavře bez uložení změn. 
 
Pozn.. Když se informace o pacientovi aktualizují pomocí dialogového okna zobrazí se aktualizace v otevřené datové 
sadě. To umožňuje uživatelům nVISION sledovat a nahrávat změny u pacient beze změny souboru historie pacienta. 

 
 
 
1.   Čas záznamu - automaticky se vyplní údajem o datu a čase. Datum / čas může být změněn. 
2.   Příjmení pacienta - omezeno na 30 alfanumerických znaků. Vyhledávací kritéria v souboru pacientovi   
      historie. 
3.  Jméno pacienta - omezeno na 16 alfanumerických znaků. 
4.  Lékař - omezeno na 40 alfanumerických znaků. 
5.  Střední jméno pacienta - omezeno na 14 alfanumerických znaků. 
6.  Identifikační číslo pacienta - omezeno na 12 alfanumerických znaků. Vyhledávací kritéria v souboru pacientovi 
     historie. 
7.  Výška pacienta - omezeno na číselné znaky. 
8.  Datum narození pacienta ve formátu rok/měsíc/den. 
9.  Hmotnost pacienta - omezeno na číselné znaky. 
10. Věk pacienta - automaticky se vyplní, když je vyplněno pole datum narození. 
11. Pohlaví - možnosti zahrnují muž (male), žena (female) a nespecifikováno. Výchozí je nespecifikováno. 
12. Poznámka 1 / Poznámka 2 - každá poznámka je omezena na 40 alfanumerických znaků. 
13. Komentáře - omezeno na 80 alfanumerických znaků. 
14. Název souboru - automaticky se naplní názvem souboru přidružené sady dat. 
15. Tlačítko Aktualizovat (update) – pokud potvrzeno, informace o pacientovi se aktualizují a jsou automaticky 
       uložené v záznamu. Dialogové okno se zavře. 
16. Tlačítko Storno (Cancel) - zavře dialogové okno bez uložení změn. 
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Úpravy uložených informací o pacientech 
 

 
 
1. Klikněte na Úpravy> Soubor historie pacientů (Edit > Patient History File). Zobrazí se dialogové okno. 
2. V případě potřeby vyberte kritéria vyhledávání (Příjmení nebo ID pacienta) a zadejte hledaný text. Informační  
    záznamy o pacientech seřazených podle vybraného kritéria se zobrazí v dialogovém okně pod jménem pacienta 
   (Patient name) a ID pacienta (Patient ID). 
3. Vyberte pacienta a klikněte na upravit (Edit). Zobrazí se dialogové okno Soubor historie (Edit Patient History  File). 
4. Upravte informace o pacientovi. 
   • Klikněte na Hotovo (Done). Aktualizace informací o pacientovi proběhne a dialogové okno se zavře.. 
   • Klikněte na Zrušit (Cancel) . Dialogové okno se zavře bez uložení změn. 
 
 
Zrušení informací o pacientovi. 
 

 
 
1. Klikněte na Úpravy> Soubor historie pacientů (Edit > Patient History File). Zobrazí se dialogové okno. 
2. V případě potřeby vyberte kritéria vyhledávání (Příjmení nebo Pacientovo ID – Last name or Patient ID) 
   a zadejte hledaný text. Informace o pacientech seřazené podle vybraných vyhledávacích kritérií, se zobrazí v okně  
   Patient Name/Patient ID. 
3. Vyberte záznam pacienta a klikněte na Odstranit (Delete). Potvrďte kliknutím na yes smazání v dialogovém oknu    
   Confirm Delete s názvem pacienta. 
• Klepnutím na No zavřete dialogové okno Confirm Delete. Záznam o pacientovi není odstraněn. 
• Klepnutím na Yes odstraníte záznam pacienta a okno Confirm Delete se zavře. 
 
Pozn.: Odstraněním informací o pacientovi se neodstraní žádné související případové studie. Ty musejí být odstraněny 
jednotlivě. 
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Menu možnosti (Options Menu) 
 
Menu možnosti umožňuje uživatelům konfigurovat a uložit parametry nVISION. nVISION používá výchozí parametry, 
dokud se nastavení nezmění. 
 
• Comm Port  - komunikační port 
• Data Path  - datová cesta 
• XML Options  - možnosti XML 
• Analysis Parameters - parametry analýzy 
• Display Parameters - zobrazit parametry 
• Language  -  jazyk 
 
 
 
 
 
 
Comm Port – komunikační port 
 
Dialogové okno komunikační port slouží k výběru komunikačního portu (COM port) pro datový kabel.  
 

 
 
 
1. Klikněte na Možnosti> Komunikační port. (Options> Comm port). Otevře se dialogové okno Komunikační port. 
2. Pomocí rozbalovací nabídky vyberte příslušný komunikační port. V případě potřeby aktualizujte kliknutím  
    na na ikonu Obnovit (Refresh). 
• Klepnutím na OK uložíte vybraný komunikační port a použít pro sběr dat. Dialogové okno se zavře. 
• Klikněte na Zrušit (Cancel) pro zavření okna bez uložení změn. 
 
 
Data Path - datová cesta 
 
Dialogové okno Vybrat cestu pro ukládání dat (Select Data Storage Path) se používá k nastavení výchozí cesty pro 
ukládání dat. nVISION ukládá data do tohoto vybraného adresáře.   
 
 
 
Kliknutím na Možnosti> datová cesta (Options > Data Path)  
otevřete dialogové okno. 
• Klepnutím na OK uložte vybraný adresář a zavřete dialogové okno. 
• Klepnutím na Procházet (Browse) otevřete okno Vybrat složku. Přejděte do 
   příslušné složky. 
• Klepnutím na tlačítko Storno (Cancel) zavřete dialogové okno bez výběr složky. 
• Klepnutím na Otevřít (open) vyberte adresář a vraťte se do okna Select Data Storage Path. Cesta k adresáři by se   
  měla zobrazit v dialogovém oknu. 
• Klepnutím na tlačítko Storno zavřete dialogové okno bez uložení změn. 
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XML Options - možnosti XML 
 
K otevření okna XML Options klikněte na Options >  XML Options. 
 
 

  
 
1.  Cesta XML - výchozí cesta pro ukládání dat pro soubory XML. 
2.  Barva grafů - pokud je vybrána, čáry grafu v grafických souborech XML odpovídají barvám obrazovky. Pokud není   
     vybrána, čáry grafu jsou černé. 
3.  Automatické ukládání souborů XML - je-li vybráno, jsou soubory XML generovány a ukládány a spojeny  
     s informacemi o pacientovi. 
4.  Automatické uložení souboru PDF - pokud je vybráno, vygeneruje se a uloží se soubor PDF a spojena s informacemi  
     o pacientovi. PDF se uloží do výchozího adresáře nVISION. 
5.  Tlačítko OK - potvrdí všechny změny provedené v dialogovém okně Možnosti XML a okno se zavře. 
6.  Tlačítko Procházet (Browse) - otevře se okno Select Folder pro změnu výchozího adresáře úložiště soubory XML. 
7.  Tlačítko Cancel -  zavře dialogové okno bez uložení změn. 
 
 
Analysis Parameters - parametry analýzy 
 
Výchozí parametry systému nVISION lze změnit tak, aby odrážely protokol zařízení. Když jednou změněny, parametry 
se použijí na všechny nová stažená data. 
 
Událost (Event) je určena uživatelsky vybranými parametry analýzy a nastává tehdy, když kritéria události jsou splněna 
nebo překročena. 
 
• SpO2 data jsou vyhodnocena na základě známých vzorců výskytu desaturace. Data nemusí být označena jako 
   událost, pokud je desaturace postupná (např. trvání delší než 2 minuty). 
• Údaje o tepové frekvenci se vyhodnocují na základě zaznamenaných trendů. Aktuální hodnota je porovnána s 
  předchozí hodnota, zda jsou splněna nebo překročena kritéria události. Kromě toho, pokud jde trend vzhůru, musí být    
  překročeno 100; pokud je trend klesající, musí tepová frekvence klesnout pod 60 BPM (tepy za minutu). 
• Údaje o rychlosti dýchání se vyhodnocují v časovém intervalu od posledního dechu. 
• Kapnografická data jsou vyhodnocena podle minimálních a maximálních hodnot EtCO2. 
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Analyzovatelné parametry 
 
Uživatelské nastavení následujících parametrů se provádí v okně System Analysis Parameters. 
 
Parametry SpO2 – jak procentuální pokles pro událost (%), tak minimální doba trvání události (s) musí být splněny, aby 
byla událost zaznamenána. 
 
Procentní pokles pro událost (defaultní nastavení výrobcem je 4%). Hodnota v %, aby se kvalifikovala jako desaturace 
SpO2 události. 
 
Minimální doba trvání (defaultní nastavení výrobcem je 10 sec.). Minimální trvání, které musí být překročeno, aby se 
kvalifikovalo jako událost SpO2. 
 
Kritéria úrovně desaturace (%). (defaultní nastavení výrobcem je 88 %). Hodnota, pod kterou musí úroveň SpO2 
klesnout, aby bylo klasifikováno jako událost desaturace. Označeno červenou přerušovanou čarou v grafu SpO2. 
 
6 minutový test chůze.  Nastaví frekvenci dat pro hlášení 6 minut chůze. Může být buď 30 sekund nebo 1 minuta. 
(defaultní nastavení výrobcem je 30 sec.). 
 
Parametry tepové frekvence - změna frekvence pro událost (pulsy za 1 minutu) a minimální trvání události (sec) musí 
být splněny, aby mohla být událost zaznamenána.  
 
Změna frekvence pro událost (pulsy za 1 min). Hodnota v tepech za minutu, aby byla kvalifikováno jako událost. 
(defaultní nastavení výrobcem je 6 pulsů za minutu). 
 
Minimální doba události. Minimální trvání, které musí být překročeno, aby se kvalifikovalo jako událost tepové frekvence. 
(defaultní nastavení výrobcem je 8 sec.). 
 
Parametry respirace - kritéria pro označení události respirační pauzy (doba mezi dechy). Hodnota v sekundách, od 
posledního dechu, aby se kvalifikovalo jako respirační pauza. (defaultní nastavení výrobcem je 30 sec.). 
 
Parametry kapnometrie. 
 
Minimální hodnota CO2 v mmHg, aby byla kvalifikována jako kapnografická událost. Zobrazí se v grafu kapnografie 
jako modrá přerušovaná čára. (defaultní nastavení výrobcem je 25 mmHg). 
 
Maximální hodnota CO2 v mmHg, aby byla kvalifikována jako kapnografická událost. Zobrazí se v grafu kapnografie 
jako červená přerušovaná čára. (defaultní nastavení výrobcem je 55 mmHg). 
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Display Parameters (partametry zobrazování). 
 
Parametry zobrazení jsou charakteristiky grafu, které jsou nastaveny nebo upraveny tak, aby se získal požadovaný 
výstup. Dialogové okno Display Parameters umožňuje uživateli zvolit, kolik času se bude zobrazovat 
v okně nVISION a nastavit rozsah hodnot pro SpO2, tepovou frekvenci nebo frekvenci respirace  na ose y. 
 
Chcete-li otevřít dialogové okno Parametry zobrazení, klikněte na Možnosti> Zobrazit parametry Options >  Display 
Parameters nebo na ikonu parametrů. 
 

 
 
1.  Časový interval (HH: MM) - Časový interval je čas zobrazení, který je v levém dolním rohu obrazovky 
stavový řádek okna. Časový interval je množství dat, které se zobrazí na jedné obrazovce nebo na jedné vytištěné 
stránce pruhového grafu (strip chart) a úplné studijní zprávy (full study report). Snížení časového intervalu umožňuje 
větší rozlišení dat. Toto pole je šedé, pokud je označeno Všechna data (All Data). 
Chcete-li nastavit časový interval, zrušte zaškrtnutí políčka Všechna data a zadejte buď časový interval (HH: MM) nebo 
pomocí šipek nahoru / dolů (5minutové přírůstky) vyberte požadovaný interval. 
 
2.  Všechna data (All data) - Pokud je políčko zaškrtnuto, osa x se automaticky nastaví tak, aby se všechna data vešla 
na monitor při prohlížení pomocí sestavy Strip Chart nebo při tisku se zprávou Úplné studium – Full Study report  
(v některých případech může být mimo obrazovku až 5 minut dat). Možnost Časový interval [HH: MM] je deaktivována. 
 
3.  Maximum SpO2 (%) - horní mez na ose y grafu SpO2. Minimum SpO2 (%) - dolní mez na ose y grafu SpO2. 
 
4.  Maximální tepová frekvence (pulsy/min) - horní limit na ose y pro graf pulzní frekvence. Minimální tepová frekvence – 
     dolní limit na ose y pro graf pulzní frekvence. 
 
5.  Maximum ETCO2 (mmHg) - horní mez na ose y grafu kapnografických dat. 
 
6.  Kapnografické jednotky - vyberte jednotky pro zobrazení kapnografických dat. 
 
7.  Zaškrtávací políčka povolí nebo zakáže grafy SpO2, tepové frekvence a frekvenci dýchání u následujících zobrazení   
     oxymetrie (Oximetry), pruhového grafu (Strip chart), úplné studie (Full Study) nebo shrnutí (Summary). 
 
8.  Šířka čáry grafu - šířka (síla) čáry použité v grafech. Úzká linka poskytuje nejvíce rozlišení; ostatní šířky jsou  
     užitečné při faxování zpráv. 
 
9.  Tlačítko OK - uloží změny a zavře dialogové okno. Změny budou použity při příštím otevření nVISION. 
 
10. Tlačítko Storno(Cancel)  - zavře dialogové okno bez uložení změn. 
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Report Menu  
 
Dialogové okno Report a šest různých zobrazení dat jsou k dispozici prostřednictvím rozbalovací nabídky Report. 
 

 
 
V jeden čas lze vybrat pouze jeden typ reportu. V nabídce Report má aktuální typ hlášení a zaškrtněte vedle názvu. 
 
Pozn.: Aby uložená data mohla korelovat s 24 hodinovým časem, musí být nastaven čas a datum v oxymetru před jeho 
použitím u pacientů. Pokud v oxymetru není nastaven čas a datum, nVISION automaticky přiřadí čas a datum 
nastavený v počítači v době stahování. 
 
 
 
nVISION Reporty 
 
Hlavní rysy reportů 
 
Nadpis každého reportu obsahuje následující informace: 
 
• Název reportu se vytiskne v levém horním rohu každé stránky. 
• Data pacienta se tisknou pod názvem reportu 
• Pod údaji o pacientovi se vytisknou informace o datu a čase spojené s reportem. 
• Komentáře vložené do souboru historie pacientů se tisknou pod datum / čas. 
 
V grafech, které se zobrazují v reportech jsou: 
 
• SpO2 data se v grafu SpO2 zobrazují zeleně. Šedé přerušované linky jsou znázorněny každých 10 procent. Linky jsou 
zobrazeny každých 5 procent, pokud minimální a maximální SpO2 hodnoty jsou od sebe 20%. 
• Údaje o tepové frekvenci se v grafu tepové frekvence zobrazují modře. Šedé přerušované linky jsou rozloženy 
každých 10 pulsů za minutu. Linky jsou zobrazeny každých 20 BPM, pokud hodnoty minimální a maximální tepové 
frekvence hodnoty jsou od sebe více než100 pulsů za minutu. 
• Data o respirační frekvenci se zobrazují fialově v reportu o respirační frekvenci. Šedá, přerušované linky jsou 
rozloženy každých 10 BPM. 
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Výchozí Report (Default Report) 
 
Dialogové okno Výchozí Report umožňuje uživateli vybrat jinou výchozí defaultní sestavu, než je Report Oxymetrie.  
Pozn.: nVISION musí být restartován, aby se tato změna projevila. 
 
 

 
 
 
 
Jednotky měření  
 
Dialogové okno Report Title umožňuje uživateli vybrat měrné jednotky (in./lb nebo cm / kg) pro výšku/hmotnost  
v informacích o pacientovi. 
 
1. Klikněte na Report> Report Title. 
2. Vyberte měrné jednotky. 
• Klepnutím na OK uložte změny. Dialogové okno se zavře. 
• Klepnutím na tlačítko Storno zavřete dialogové okno bez uložení změn. 
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Popisy polí nadpisu sestavy 
 
Ve všech reportech se pod jeho názvem zobrazují údaje o pacientech a podrobnosti o čase. 
 

 
 
 
Patient Data :  Blok informací o pacientovi - obsahuje jméno, pohlaví, věk, datum narození (DOB), výška, hmotnost, BMI 
(index tělesné hmotnosti), lékař, ID a poznámky. BMI je určena výškou a hmotností. BMI = hmotnost (kg) / výška (m) 2. 
měrné jednotky výšky a hmotnosti se nastavují prostřednictvím Report > Report Title. 
 
Time :  Čas zahájení nahrávání (podle hodin nastavených v oxymetrech) v hodinách, minutách, sekundách (HH: MM: 
SS).  Pokud čas a datum nejsou nastaveny před zaznamenáním dat do paměti oxymetrů, nVISION automaticky 
přiřazuje čas a datum nastavené v počítači v době stahování dat. 
 
Duration :  Celková doba (HH: MM: SS). 
 
Analyzed :  Celková doba s odečtenými vyloučenými daty. Doba trvání - vyloučený čas = analyzovaný čas. 
 
Comments : Importováno ze souboru informací o pacientovi, který je spojen s daty. 
 
 
 
Report oxymetrie – Oximetry Report (výchozí zpráva) 
 
Report oxymetrie je přehled, který poskytuje jednostránkový souhrn údajů o SpO2 pacienta a tepovou frekvenci během 
monitorovacího období. Report oxymetrie se zaměřuje na definovaná data událostí podle parametrů analýzy. 
Vyloučené segmenty se v grafech zobrazují se zkříženým vzorem. 
 
Kromě nadpisu sestavy má zpráva tyto sekce: 
• Číselný souhrn dat - rychlost ukládání dat, podrobná událost,% SpO2 a údaje o tepové frekvenci. 
• Parametry analýzy - parametry použité k analýze sady dat a výpočtu a hlášení událostí. 
• Grafické shrnutí - zahrnuje data SpO2, události SpO2, data o tepové frekvenci, události o tepové frekvenci, a čas. 
   Události jsou označeny černými svislými čarami pod každým grafem. Červená přerušovaná linka na grafu SpO2   
   označuje úroveň desaturačních kritérií (Edit > Analysis Parameters). Souhrnné histogramy SpO2 se zobrazují ve  
   spodní části sestavy. 
    • % času stráveného na úrovni SpO2 - procentuální rozložení času na dané úrovni SpO2 nad monitorovací období.    
      Osa y je označena% času a osa x je označena hodnotou SpO2 (100 - 30%). 
   • SpO2 události podle úrovně SpO2 v krocích po 5%. Osa y je počet událostí a  osa x je označena hodnotou SpO2  
     (100 - 30%). 
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Ukázka reportu oxymetrie  
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Popis Reportu Oxymetrie 
 
Data Storage Rate - rychlost, s jakou byla data uložena v oxymetru (např. Jednou za sekundu, jednou za 2 sekundy, 
jednou za 4 sekundy). 
 
Event Data - nadpis pro sekci dat o událostech. 
 
Total Events - celkový počet událostí během kteréhokoli měřeného časového období. 
 
Time in Events - součet časových trvání pro všechny události. 
 
Avg. Event Dur. - průměrná doba trvání události, což je průměrná doba v sekundách na událost. 
 
Index - Statistiky studie spánku, počítané jako události za hodinu. Toto je „surový“ index hodnota pouze pro puls. 
 
Oxygen Desat Index - statistika studie spánku, vypočtená jako události za hodinu. Kolikrát za hodinu SpO2 klesl o 
určitou úroveň od základní hodnoty. 
 
% Articact - procento časových údajů které chyběly nebo byly vyloučeny. Například, pokud je studie 6 hodin a 1 hodina 
je stanovena jako artefakt, % Artefakt se počítá takto: 1/6 = 16% 
 
Adjusted Index - Statistiky studie spánku, vypočtené jako události za hodinu „analyzovaných dat“ (artefakty a vyloučené 
údaje nejsou zahrnuty).  Upravený index = počet událostí / doba bez artefaktu (hodiny). Příklad, pokud záznam pacienta 
obsahuje 300 událostí za dobu záznamu 4 hodiny a 1 hodina dat je vyloučena, upravený index se počítá takto: 
300/3 = 100 (události za hodinu) 
 
% SpO2 Data - nadpis pro sekci dat SpO2. 
 
Basal SpO2 - Ustálený stav SpO2. Průměr odečtů SpO2, které nejsou zahrnuty v jakékoli desaturační události. 
 
Time (min) <88% - délka času během studie, kdy hodnota SpO2 byla pod 88%. 
 
Events <88% - počet událostí zachycených během studie, kdy byla hodnota SpO2 pod 88%. 
 
Max. jeden čas <88% - nejdelší jediný čas v průběhu studie, kdy hodnota SpO2 byla pod 88%. 
 
Minimum SpO2 (%) – nejnižší zaznamenaná SpO2 hodnota. 
 
Avg. Low SpO2 (%) - průměr nejnižšího SpO2 pozorovaného ve všech událostech. 
 
Avg. Low SpO2 <88% - průměr všech hodnot SpO2, které byly pod 88%. 
 
Pulse Data - okruh pro sekci údajů o tepové frekvenci. 
 
Avg. Pulse Rate (bpm) - průměr všech hodnot tepové frekvence během studie. 
 
Low Pulse Rate (bpm) - nejnižší tepová frekvence během studie. 
 
% SpO2 Level / Events - zobrazuje počet událostí, které se vyskytují v každém intervalu 5 procent od 30% do 100%. 
 
Below / Time (%) - zobrazuje kumulativní procento času stráveného pod každým 5 procentním bodem interval od 30% 
do 100%. 
 
Analysis Parameters - parametry použité k definování kritérií, podle nichž jsou události detekovány a zobrazovány. 
 
Graphic Summary - zahrnuje grafy SpO2 a tepové frekvence spolu s pruhem událostí pod každým grafem. Lišta 
událostí ukazuje, kde k událostem došlo, při analýze byly použity nastavené parametry. 
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Strip Chart Report 
 
Sestava Strip Chart se používá k prohlížení, analýze a úpravám dat. Zpráva Strip Chart umožňuje uživateli zobrazit 
surová data jako vizuální záznam grafu. Uživatel pak může data vyhodnotit a provést nezbytnou analýzu, aby se vyloučil 
artefakt (poškozená nebo nesmyslná data) a vybere měřítka pro tisk zprávy úplné studie (full study report). Vyloučené 
segmenty se v grafech zobrazují se zkříženým vzorem. 
 
Kromě nadpisu sestavy má zpráva sekci grafické shrnutí (Graphic summary): 
 
Grafické shrnutí - poskytuje podrobné grafické znázornění SpO2, tepové frekvence, údaje o respiraci (pokud jsou k 
dispozici) a čas. Události jsou označeny černými pruhy nad daty v každém příslušném grafu. Červená přerušovaná 
vodicí čára v grafu SpO2 označuje úroveň desaturačních kritérií (parametr analýzy). Data artefaktů jsou v grafu viděna 
jako mezera, takže nejsou interpretována jako událost. 
 
Pozn.: Sestava Strip Chart vytiskne jednu stránku dat na obrazovce a poskytuje uživatelům metodu pro dokumentaci 
konkrétních datových sekcí. Pokles časového intervalu umožňuje větší rozlišení dat v této zprávě. 
 
Pozn.: Nejnižší hodnota SpO2 je zobrazena nad grafem SpO2. 
 
Ukázka Strip chart report : 
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Full Study Report 
 
Report Úplná studie (Full Study Report) graficky zobrazuje všechna zaznamenaná data. Tento report může být více než 
jednu stránku dlouhý, v závislosti na délce záznamu a časovém intervalu zvoleném v okně Display Parameter Dialog 
Box. Vyloučené segmenty se v grafech zobrazují se zkříženým vzorem. 
 
Kromě nadpisu sestavy má tento report sekci Grafické shrnutí (Graphic Summary), která se zobrazuje vodorovně  
a poskytuje podrobné grafické znázornění SpO2, tepová frekvence, frekvence respirace (pokud jsou k dispozici) a čas. 
Červená přerušovaná vodicí čára na grafu SpO2 označuje úroveň desaturačních kritérií. Události jsou označené 
černými pruhy nad údaji v každém příslušném grafu. Pokles časového intervalu umožňuje větší rozlišení dat v tomto 
reportu.  
 
Ukázka Full Study Report : 
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Respiration Rate Report 
 
Report Respiration Rate poskytuje údaje o frekvenci, rychlosti dýchání a kapnografii pro pacienta během 
monitorovacího období. Respiration rate report je k dispozici pouze tehdy, pokud byly údaje o dýchání uchovány 
v paměti přístrojů. 
Frekvence dechu je časový interval od předchozího dechu a je počítána jako dechy za minutu. Pro rychlou reakci na 
změny stavu pacienta je toto měření průměrováno dech po dechu. 
Kapnografie je grafické sledování koncentrace nebo parciálního tlaku oxidu uhličitého (CO2) ve výdechu. Report 
Respiration Rate obsahuje graf kapnografických dat, pokud jsou data kapnografie stažena do nVISION. 
 
Pozn.: Všechna data kapnografie se zobrazují v mmHg. Data shromážděná v kPa (kilopascaly) se převádějí 
během stahování na mmHg. Kromě nadpisu sestavy má zpráva tyto sekce: 
• Numerical Data Summary - Podrobné údaje o událostech, respiračních datech a kapnografických datech 
  (když bude dostupný). 
• Parametry analýzy (Analysis Parameters) - parametry použité k analýze sady dat a výpočtu a zobrazení události. 
• Grafické shrnutí - Zahrnuje rychlost dýchání, události dýchací frekvence, data kapnografie, kapnografické události.   
   Události jsou označeny černými svislými čarami pod každým grafem. Dole zobrazená časová osa je sloupcový graf   
   zobrazující distribuci frekvence dýchání (Respiration Rate Frequency Distribution). 
 
Ukázka Respiration Rate Report 
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Popis Respiration Rate Report 
 
Event Data - Souhrn údajů o respiračních přestávkách, včetně celkových přestávek, času v přestávkách v 
minutách a průměrné trvání přestávek v sekundách. 
 
Respiration Data – Avg.. Respiration Rate (BrPM) - Zaznamenané průměrné dechy za minutu (BrPM) během sady dat 
Min. Respiration Rate (BrPM) - Nejnižší hodnota jednotlivých dechových frekvencí. 
 
Capnography Data - Zahrnuje průměrné, minimální a maximální hodnoty CO2 (v mmHg) pro soubor dat. Napravo od 
hodnot mmHg, jsou zobrazena data událostí kapnografie. 
 
Analysis Parameters - Parametry použité k definování kritérií, podle nichž jsou události detekovány a zobrazeny. 
 
Graphic Summary - Zahrnuje grafy frekvence dýchání a grafy kapnografie událostí pod každým grafem. V grafu 
kapnografických dat znamená oranžová přerušovaná čára maximální hodnotu události CO2 (mmHg) a modrá 
čárkovaná čára je minimální hodnota události CO2 (mmHg). 
 
Respiration Rate Frequency Distribution - Sloupcový graf s frekvencí dýchání. 
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Summary Report  
 
Souhrnná zpráva (summary report) je jednostránkový souhrn, který se zaměřuje na údaje o událostech, jak jsou 
definovány specifickým případem parametry analýzy. 
Kromě nadpisu sestavy má zpráva tyto sekce: 
• Číselný souhrn dat (numerical data summary) - rychlost ukládání dat a podrobná událost,% SpO2 a frekvence pulsu. 
• Interpretační oblast (interpretation area) - prostor pro zadávání komentářů. 
• Parametry analýzy - parametry použité k analýze sady dat a výpočtu a zobrazení události. 
• Grafické shrnutí - Zahrnuje data SpO2, události SpO2, údaje o tepové frekvenci, události o tepové frekvenci, 
   a čas. Události jsou označeny černými svislými čarami pod časovou osou. Červená přerušovaná vodicí čára na grafu   
   SpO2 označuje úroveň desaturačních kritérií. 
• Podpisový blok lékaře (physician signature block) - používá se pro účely pojištění a vedení záznamů. 
 
Ukázka Summary Report 
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Popis Report Field Descriptions 
 
Data Storage Rate - Rychlost, s jakou byla data uložena v oxymetru. 
 
Event Data - Řádek záhlaví pro datový blok události. 
 
Total Events - Celkový počet událostí během kteréhokoli měřeného časového období. 
 
Time in Events (min) - Součet časových trvání pro všechny události. 
 
Avg, Event Dur. (sec) - Průměrná doba trvání události, což je průměrná doba v sekundách na událost. 
 
Index (1/hr) - Statistiky studie spánku, počítané jako události za hodinu. Toto je „surový“ index, hodnota pouze pro puls. 
 
Oxygen Desat Index (1/hr) - Statistiky studie spánku, vypočtené jako události za hodinu „analyzovaných dat“ 
(artefakty a vyloučené údaje nejsou zahrnuty). 
Upravený index = počet událostí / doba bez artefaktu (hodiny) 
Příklad: pokud záznam pacienta obsahuje 300 událostí za období záznamu 4 hodiny a 1 hodina dat je vyloučena, 
upravený index se počítá jako následující: 300/3 = 100 (události za hodinu) 
 
% SpO2 Data - Nadpis pro sekci dat SpO2. 
 
Basal SpO2 (%) - Ustálený stav SpO2. Průměr odečtů SpO2, které nejsou zahrnuty v jakékoli desaturační události. 
 
Time (min) <88% - Množství času během studie, kdy hodnota SpO2 byla pod 88%. 
 
Max Single Time <88% - Nejdelší jediný čas v průběhu studie, kdy hodnota SpO2 byla pod 88%. 
 
Minimum SpO2 (%) - Nejnižší jednotlivá hodnota SpO2. 
 
Avg. Low SpO2 (%) - Průměr nejnižšího SpO2 pozorovaného ve všech událostech. 
 
Avg. Low SpO2 <88% - Průměr všech hodnot SpO2, které byly pod 88%. 
 
Pulse Data - Okruh pro sekci údajů o tepové frekvenci. 
 
Avg, Pulse Rate - Průměr všech hodnot tepové frekvence během studie. 
 
Low Pulse Rate - Jedna nejnižší tepová frekvence během studie. 
 
Interpretation - Prostor pro komentáře recenzentů. Otevřete dvojklikem v poli Interpretace. 
 
Analysis Parameters - Parametry použité k definování kritérií, podle nichž jsou události detekovány a zobrazeny. 
 
Graphic Summary - Zahrnuje grafy SpO2 a tepové frekvence spolu s pruhem událostí pod každým grafem. Lišta 
událostí ukazuje, kde k událostem došlo a při jakých parametrech použitých při analýze. 
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6- Minute Walk Report 
 
Report o 6 minutovém testu chůze je souhrnem všech informací souvisejících s 6minutovým testem chůze u pacienta. 
Kromě nadpisu sestavy má zpráva tyto sekce: 
• Podrobnosti testu (Testing Details) - Zahrnuje podmínky testu, data testu, vzdálenost a informace o zastávce. 
• Oblast medikace (Medication Area) - Prostor pro zadávání informací o lécích pacienta. 
• Oblast poznámek (Comments Area) - prostor pro zadávání komentářů recenzenta. 
• Podpisový blok lékaře (Physician Signature Block) - používá se pro účely pojištění a vedení záznamů. 
 
Dvojitým kliknutím kdekoli na obrazovce se otevře dialogové okno Informace o 6 minutovém testu chůze, které 
umožňuje uživateli zadat data pro všechna pole, která nejsou vyplněna oxymetrickými daty. Všechna data se 
automaticky uloží po zavření dialogového okna. nVISION zobrazí pouze první stránku sestavy (viz Ukázka 6- Minute 
Walk Report). Při tisku sestavy jsou však vytištěny jak první stránka, tak všechny další stránky s daty oxymetrie. 
 
Ukázka 6 minute walk report 
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Popis 6- Minute Walk Report 
 
Test location - Možnosti zahrnují Vnitřní a Venkovní. Zadáno z 6 minut chůze Informačního dialogového okna. 
 
Supplemental Oxygen - Rozbalovací nabídka v dialogovém okně Informace o 6 minutové chůzi. Možnosti zahrnují 
Nesení přenosného O2, táhnutí O2 vozíku, nesení přenosného O2 zaměstnanci a táhnutí O2 vozíku zaměstnanci. 
 
Walking Aids Used - Rozbalovací nabídka v dialogovém okně Informace o 6 minutové chůzi. Možnosti zahrnují 
None, Cane, Walker a Other (umožňuje uživateli zadat popis). 
 
Reason for Testing - Rozbalovací nabídka v dialogovém okně Informace o 6 minutové chůzi. Možnosti zahrnují 
těžká dyspnoe, bronchospasmus indukovaný zátěží, funkční odezva na změna v terapii, před / po PR a jiné (umožňuje 
uživateli zadat a popsat). 
 
Testing/Recovery block - Sekce testování - zobrazuje SpO2 a tepovou frekvenci ve zvoleném intervalu (30 sek./1 min.) 
pro celý 6minutový test (nastavit v nabídce Možnosti> Analýza Parametry – Options > Analysis Parameters). 
Sekce obnovy (Recovery Section) - zobrazuje SpO2 a tepovou frekvenci ve vybraném intervalu pro dobu 2 minut. 
Do okna mohou být pro každý interval vloženy další informace - O2 (l / min), krevní tlak, dušnost, odpočinek (sec). 
 
Distance Block - Do okna se zadává vzdálenost jednoho kola (stopy nebo metry) a počet kol chůze. 
Celková vzdálenost chůze se vypočítá automaticky, když je zadána vzdálenost jednoho kola a jejich počet. 
 
Stops Block - Počet zastavení při chůzi se vypočítá automaticky, jakmile jsou do systému zadány odpočinky. 
Důvody zastavení je rozbalovací nabídka v dialogovém okně 6 Minute walk information. Možnosti zahrnují SOB 
(dušnost), únavu, bolest, křeče na nohou a ostatní (umožňuje uživateli zadat popis). 
Celkový čas zastavení (v sekundách) se automaticky vypočítá na základě časů vložených do sloupce Rest c sekci 
testování (Testing Block). 
 
Medication – vloženo z 6 Minute Walk Information dialog box. 
 
Comments - vloženo z 6 Minute Walk Information dialog box. 
 
Physician signature block - Prostor pro podpis / datum lékaře, jméno osoby, která studii provedla, a nálepka pacienta. 
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Help Menu 
 
Témata nápovědy 
 
Software nVISION zahrnuje online systém nápovědy a glosář podmínek. 
 

 
 
 
Použití nVision Help 
 
1. Klikněte na Nápověda> Témata nápovědy. Nápověda nVISION se otevře. 
2. Nápověda obsahuje tři možnosti hledání informace: 
    • Karta Obsah (Contens) zobrazuje obsah. 
    • Karta Rejstřík (index) zobrazuje seznam témat a vyhledávání podle klíčového slova. 
    • Karta Najít (Search) umožňuje fulltextové vyhledávání nápovědy. 
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Použití nVision 
 
Vytvoření identifikace pacienta před stažením (Doporučeno) 
 
1. Klikněte na Úpravy> Soubor historie pacientů (Edit > Patient History File). Otevře se okno Soubor historie pacientů. 
2. Pro vytvoření nového pacienta klikněte na Nový (New). Otevře se prázdné okno Upravit soubor historie pacientů. 
3. Zadejte informace o pacientovi. Vyplňte povinná pole (jméno, příjmení a ID číslo). 
4. Po dokončení: 
    • Klikněte na Hotovo (done). Aktualizace informací o pacientovi a dialogové okno se zavře. 
    • Klikněte na Zrušit (cancel). Dialogové okno se zavře bez uložení změn. 
 
 
Stahování dat 
 
Pozn.: Před prvním stažením dat vstupte do Report Title a nastavte měrné jednotky. 
 

 
 
 
1. Připojte k počítači pulzní oxymetr nebo modul TrendSense. 
2. Otevřete nVISION. 
3. Klikněte na Soubor> Nový sběr dat (File > New Data Capture) nebo na ikonu. Otevře se okno New Data Capture. 
4. V poli Select Oximeter vyberte model pulzního oxymetru. 
5. Vyberte komunikační port pro oxymetr (Select communication Port). 
6. Stahování dat zahájíte podle pokynů ve stavovém řádku nebo v poli s pokyny režim. V režimu stahování dat jsou   
    deaktivována tlačítka Select Oximeter, Start a Cancel,  tlačítko Stop je aktivováno. 
 
Pozn.: Pokud klepnete na tlačítko Start a pulzní oxymetr není v režim přehrávání (playback mode), dialogové okno 
zobrazí Not In Playback Mode. Zavřete klepnutím na tlačítko OK. 
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7. V průběhu stahování dat pacienta do PC z oxymetru nebo modulu TrendSense: 
    • se zobrazí zpráva stavového řádku, jakmile jsou data stažena 
    • ukazatel průběhu stahování ukazuje procento dokončeného přenos dat. 
    • V poli Captured Recordings se zobrazuje počáteční datum (Start Date), čas zahájení (Start time) a doba trvání   
       (duration) každého staženého soubor dat. 
    • klepnutím na Stop ukončíte stahování. Pokud není stahování dat kompletní, zobrazí se hlavní okno nVISION. 
 
Pozn.: Pokud se do nVISION nestáhnou žádné soubory, ověřte zda je správný komunikační port. 
 
8. Po stažení dat zobrazí dialogové okno Select Recordings (Vybrat záznamy) datum zahájení (start date), čas zahájení 
(start time) a dobu trvání (duration) pro každou staženou datovou sadu. 
    • segmenty dat se neuloží, dokud nejsou přidruženy k souboru historie pacientů a uloženy jako soubor .nmi. 
 
9. Klikněte na, a tím zvýrazněte řádky záznamů. nVISION umožňuje uživatelům výběr více záznamů, které mají být 
uloženy jako jeden datový soubor. 
    • Pokud nebyly nastaveny hodiny, objeví se interval 10 minut mezi datovými sadami, a čas mezi nahrávky je označen    
       jako vyloučený. 
 
10. Klepněte na Uložit (Save). Zobrazí se dialogové okno Soubor historie pacientů (Patient History File). 
 
A. Stávající pacient - klikněte na jméno pacienta a klikněte na OK. Zobrazí se okno Uložit sadu dat (save data set)  
     s informace o vybraném pacientovi. Aktualizujte podle potřeby.  
B. Nový pacient - klikněte na Nový (new). Otevře se prázdné dialogové okno Uložit data (save data set). Minimálně   
     vyplňte křestní jméno, příjmení a identifikační číslo.  
 
11. V dialogovém okně Uložit sadu dat (save data set) klepněte na Uložit (Save). Datová sada je uložena do výchozího    
      adresáře s automaticky generovaným názvem souboru. 
 
Pozn.: Název souboru obsahuje jméno pacienta, datum záznamu a dobu, čas záznamu. Během stahování dat nejsou 
povoleny změny generovaného názvu souboru. 
 
12. Dialogové okno Vybrat nahrávky (select recordings) se automaticky uzavře, pokud byly všechny sady dat uloženy. 
Pokud zůstanou nestaženy další sady dat, zobrazí se znovu dialogové okno Vybrat nahrávky(select recordings); Již 
uložená sada dat však není v dialogovém okně zobrazena. 
 
13. Opakujte kroky 9-11, dokud nebudou uloženy všechny požadované sady dat, které souvisí s pacientem. 
 
14. Klikněte na Hotovo (done). Pokud klepnete na Hotovo, ale ne všechny soubory dat byly uloženy, zobrazí se OK pro 
potvrzení, zda chcete přeskočit (skip) zbývající nahrávky. 
    • Klepnutím na Ano se vrátíte do hlavního okna nVISION. Všechny neuložená data budou z nVision vymazána. 
    • Klepnutím na Ne (not) nebo Storno (cancel) se vrátíte do dialogového okna Vybrat nahrávky (select recordings). 
 
15. Vypněte oxymetr. 
 
 
 
Informace o stahování dat podle modelu 
 
Oxymetry 3100 nebo 3150 - data, která byla v oxymetrech uložena s různými rychlostmi ukládání, nelze sloučit do 
jednoho souboru. Pouze ty sady dat, které mají stejnou frekvenci ukládání mohou být sloučena. 
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Ukládání datových sad - nový pacient bez historie pacienta 
 
Dialogové okno Uložit sadu dat (save data set) poskytuje prostor pro zadání informací o pacientovi, které budou spojeny 
se specifickými sadami dat vybranými v postupu Stažení dat. 
 
Pozn.: Razítko data / času se nastaví automaticky do pole Záznam (recording field). Název souboru zahrnuje jméno 
pacienta, datum a čas záznamu. Po zadání textu se název souboru aktualizuje. 
Pokud není nastaveno datum a čas oxymetru, nVISION zabrání uložení souborům se stejnými jmény pomocí data a 
času nastaveného v počítači při stahování dat. 
 
 
 

 
 
 
Do každého pole zadejte informace o pacientovi - příjmení, jméno, prostřední jméno, lékař, ID číslo, výška, hmotnost, 
pohlaví a DOB (datum narození). Když je zadán DOB, nVISION automaticky vypočítá věk pacienta podle aktuálního 
systémového data počítače. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

36 

 

Ukládání datových sad - existující pacient s historií. 
 
U stávajících pacientů se zobrazí dialogové okno Uložit data (save data set) s úplnými informacemi o pacientovi 
kromě pole Poznámky. Pole Poznámky umožňuje přidružení jedinečného textového řetězce se sadou dat. 
 

 
 
 
 
Úpravy a analýza dat 
 
Analýza dat je primárně úkolem úprav parametrů tak, aby výsledné určení události a statistiky dávaly smysl. Pomocí 
příkazu Zobrazit parametry (display parameters) změňte rozlišení dat a pomocí příkazu Parametry analýzy (analysis 
parameters) nastavte požadovaná kritéria události. 
 
1. Otevřete uloženou datovou sadu pomocí Soubor> Otevřít uložená data (file > open saved data) . Soubor se otevře 
jako zpráva oxymetrie. 
 
2. Upravte parametry zobrazení Možnosti> Zobrazit parametry (Options> Display Parameters)  na požadované hodnoty, 
    aby se formátovala zpráva, která bude vytištěna. 
    A. V případě potřeby deaktivujte všechna data. 
    B. Pro zvětšení nebo zmenšení měřítka upravte další charakteristiky grafu, aby se přesně vyhodnotily body artefaktu. 
3. Klepnutím na OK uložte změny. 
4. Změňte zobrazení sestavy na sestavu Strip Chart. 
5. Identifikujte a vylučte data artefaktů. 
    A. Umístěte kurzor na libovolný bod grafu. Klepnutím pravým tlačítkem zobrazíte čas tohoto bodu a hodnoty dat  
         v pravém dolním rohu okna. 
    B. Pomocí navigačního tlačítka, kláves se šipkami nebo kláves Page Up / Page Down se pohybujte v datech. 
    C. Vyberte oblasti zájmu. Kliknutím do oblasti zájmu zobrazíte vybraný časový interval ve stavovém řádku. 
    D. Chcete-li zobrazit souhrnné statistiky pro uzavřenou oblast, klikněte na Úpravy> Souhrnná data (edit>summarize   
         data). Zobrazí se dialogové okno Souhrnná statistika (summary statistics). 
 
Pozn.: Dialogové okno Souhrnná statistika (summary statistics) zobrazuje data dýchací frekvence (RespRate), i když se 
           nezobrazí na obrazovce. Avšak jen tehdy, pokud jsou tato data součástí uloženého souboru dat. 
 
    E. Klepnutím na Vyloučit (Exclude) přijměte výběr dat. Klepnutím na tlačítko Storno (cancel) se vrátíte do zobrazení   
         Strip chart report.. 
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 F. Chcete-li vyloučit data, klikněte na Upravit> Vyloučit data (edit > exclude data). Kliknutím na OK uložíte vyloučený 
      segment dat. Oblast je nyní označena šrafovaným vzorem. 
 G. Vrátit zpět jakékoli, nebo všechny vybrané datové sekvence provedete kliknutím na Zpět nebo Vrátit vše (undo nebo 
undo all) v okně Vyloučit data (exclude data box). 
 
6. Po vyloučení artefaktu klikněte na Soubor> Uložit (file > save) nebo Soubor> Uložit jako (file > save as) a uložte 
úpravy do dat. 
 

 
Procvičení práce s daty, soubory 
 
K dispozici jsou vzorové datové soubory (případové studie pacientů), abyste mohli vyzkoušet práci s nVISION. Tento 
výukový program používá jednu ukázkovou datovou sadu. 
 
1. Otevřete nVISION. 
2. Klepnutím na Soubor> Otevřít uložená data (file>open saved data) získáte přístup k ukázkovým souborům dat. 
3. Vyberte „Miller, GT 30 Duben 2000 23.57.09-06.14.17.nmi.“ 
4. Klepněte na Otevřít (open). Datová sada se otevře jako zpráva oxymetrie (oximetry report). 
 
 
Analýza dat pomocí sestavy pásového grafu (strip chart report). 
 
1. Chcete-li připravit data souboru Miller pro analýzu, klikněte na Report> Strip Chart Report. Tento graf poskytuje: 
 
• Grafické znázornění dat (např. SpO2 a tepová frekvence). U každého je uveden časová osa x grafu. 
• Události jsou černé značky nad údaji v každém grafu. nVISION hodnotí události podle použitých parametrů analýzy   
   vybraných uživatelem. 
• Čas zobrazení se nachází v levém dolním rohu stavového řádku. Čas zobrazení je hodnota času nastaveného v poli  
  časový interval (HH: MM) na obrazovce Parametry zobrazení (display parameters). 
• iplynulý čas je umístěn ve středu stavového řádku a aktualizuje se podle toho, jak procházíte sestavou (použijte  
   klávesy se šipkami nebo posuvník). 
• Čas kurzoru nebo vybraný čas (cursor time nebo selected time) je umístěn na pravé straně stavového řádku. 
   - ćas kurzoru -  Kliknutím pravým tlačítkem myši na graf dat zobrazíte data SpO2 a hodnoty pulzů. 
   - Vybraný čas - když je segment označen, zobrazí se počáteční čas a délka  
 
POZNÁMKA: Aby uložená data mohla korelovat s 24hodinovým časem, musí být nastaven čas a datum v oxymetru 
před zaznamenáním údajů o pacientech. Pokud před zaznamenáním dat není nastaven čas a datum, nVISION 
automaticky přiřadí čas nastavený v počítači v době stahování dat. 
 
2. Přejděte od začátku do konce sestavy. Použijte klávesy se šipkami nebo posuvník. 
3. Pro účely posuzování budeme podrobněji analyzovat konkrétní sekce. Klikněte na Options > Display Parameters. 
 
4. Změňte hodnoty parametrů zvýrazněním aktuální číselné hodnoty v každém poli a zadejte nové hodnoty. Pomocí 
klávesy Tab přejděte na další pole nebo klepněte přímo do pole. 
    A. Zrušte zaškrtnutí políčka Všechna data. 
    B. Do pole Časový interval (time interval field) zadejte 01:00. Časový interval označuje množství dat (v hodinách 
        a minutách), které se zobrazí na obrazovce (v tomto případě 1 hodina dat). 
    C. Do pole Maximum SpO2 (%) zadejte 98. 
    D. Do pole Minimální SpO2 (%) zadejte 70. 
    E. Do pole Maximální tepová frekvence zadejte 140. 
    F. Do pole Minimální tepová frekvence zadejte 60. 
 
5. Klepněte na OK. Všimněte si, že v první hodině studie se zobrazí dvě události SpO2 a tři události tepové frekvence. 
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Vyloučení a sumarizace dat 
 
Oblast zájmu označená červeným obdélníkem přerušovanou čarou je nakreslena v reportu Strip chart report a používá 
se k identifikaci konkrétního bloku dat. Po identifikaci může uživatel zkontrolovat statistiku shrnutí údajů v obdélníku, 
identifikovat a vybrat oblasti artefaktu (poškozené nebo nesmyslné údaje) a vyloučit je z další analýzy. 
 
Pozn.: Vyloučená data jsou v grafech označena zkříženým vzorem, ale nejsou vyloučena z jakékoli zprávy. Šrafovaný 
vzor je odstraněn, když jsou vyloučená data vymazána (ne vyloučena). Vyloučená data jsou zahrnuta do výpočtu % 
artefaktu (oximetry and summary reports). Vyloučená data nejsou použita v dalších výpočtech ve reportu oxymetrie. 
Analyzovaný čas má vyloučené údaje odečteny od doby trvání. 
 
1. Chcete-li vytvořit oblast zájmu, klikněte a přetáhněte myš v jednom z grafů. Během tažení kurzoru jsou hranice 
vybrané oblasti označeny čárkovanou čarou v každém z grafů. Hranice obdélníku se pohybují s myší. 
2. Klikněte a podržte myš v grafu tepové frekvence počínaje šestou minutou; uvolněte v 11 minutě. 
3. Klepněte na Upravit> Souhrnná data (edit > summarize data), abyste z dat získali statistické souhrnné informace. 
Zobrazí se statistický přehled obdélníku, který vám umožní vyloučit segmenty dat z tohoto dialogového okna. Klikněte 
na Vyloučit> OK (exclude > OK) . 
4. Chcete-li vyloučená data vymazat nebo vrátit zpět, klikněte na Upravit> Vyloučit data (edit > exclude data). 
5. V dialogovém okně Exclude data segments kliknutím na Zrušit vše (undo all) zrušte všechna vyloučená data nebo 
klikněte na požadovaný segment dat (pro tento příklad „00:06:01 - 00:11:01“). Všimněte si segment dat je nyní 
zvýrazněn. Klikněte na Zpět (undo). 
 
Ukládání dat 
 
Chcete-li uložit změny provedené v sadě dat (tj. Jakékoli úpravy, změny parametrů analýzy atd.), klikněte na Soubor> 
Uložit (file > save) . Případ je uložen a přepíše předchozí sadu dat. 
 
Chcete-li tyto parametry uložit jako samostatnou datovou sadu, klikněte na Soubor> Uložit jako (file > save as) a uložte 
datovou sadu s novým názvem souboru. 
 
Pozn.: Pokud je datová sada uzavřena před uložením změn, datová sada se vrátí na poslední uložená data. 
 
 
Technická podpora 
 
Nonin Medical, Inc. 
13700 1st Avenue North 
Plymouth, MN 55441 USA. 
 
Nonin Medical B.V. 
Prins Hendriklaan 26 
1075 BD Amsterdam, Nizozemsko 
Telefon: 800.356.8874 (USA / Kanada) 
+1,763,553.9968 
+31 (0) 13 - 79 99 040 (Evropa) 
Fax: +1,763,553,7807 
+31 (0) 13 - 79 99 042 (Evropa) 
E-mail: technicalservice@nonin.com 
technicalserviceintl@nonin.com 
Web: nonin.com 
 
Pozn.: Technická podpora Nonin Vás vždy požádá o kód softwarového klíče nVISION, který je zobrazen v okně About 
nVISION a je také vytištěno na obalu nVISION CD-ROM. 


